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 Multiple Choice

This button allows you to select for the current question the Multiple Choice type. The user must select 
the right answer among the presented ones. The choices can range from 2 to 6.

Example:
When did World War Two break out?
A. 1938
B. 1939
C. 1940
Right answer: B



 Insertion

This button allows you to select for the current question the Insertion type: the user must enter his/her 
answer.

Example:
When did World War Two break out?
Right answer: 1939



 True / False

This button allows you to select for the current question the True / False type: the user must specify if the 
statement is true or false. The number of statements can range from 1 to 6.

Example:
World War One broke out in 1913 [T] [F]
World War Two broke out in 1939 [T] [F]
World War Two finished in 1945 [T] [F]
Right answer:[F] [T] [T]



 Association

This button allows you to select for the current question the Association type: the user must associate a 
sentence with its relative complement. The number of associations can range from 2 to 6.

Example:
[A] Broke out World War One          [1] 1945
[B] Broke out World War Two [2] 1914
[C] Finished Second World War [3] 1939
Right answer: [A-2] [B-3] [C-1]



    Change current Toolbar

This command allows you to change the current Toolbar, selecting it between the two available. All the 
buttons can be personalized selecting the Toolbar... command in the Options menu.



    Create new questionnaire

This command allows you to create a new questionnaire. WinAsks Editor shows then the window for 
questionnaire insertion and management.



    Create new analysis

This command allows you to create a new analysis of the results of a questionnaire or survey. Then, 
WinAsks Editor shows the window for analysis creation and management.



    Open file

This command allows you to open a previously saved file. WinAsks Editor can open questionnaires and 
analyses files, using their respective management windows.



    Save file

This command allows you save on disk a file created previously. If the file was not given a name, 
WinAsks Editor shows a window for its insertion.



    Cut

· If the window for questionnaires or analyses (table) is active
This command allows you to delete the text selected and put it into the Clipboard. To use the text 
contained in the Clipboard, choose the Paste button in the Edit menu.

· If the window for analyses (chart) is active
This command allows you to copy the current chart into the Clipboard in WMF format.



    Copy

· If the window for questionnaires or analyses (table) is active
This command allows you to copy the text currently selected into the Clipboard. To use the text 
contained in the Clipboard, choose the Paste button in the Edit menu.

· If the window for analyses (chart) is active
This command allows you to copy the current chart into the Clipboard in BMP format.



    Paste

This command allows you to transfer the text contained in the Clipboard to the active window. To copy a 
text in the Clipboard use the Cut and Copy commands in the Edit menu.



    View image

This command allows you to view an image. Then, WinAsks Editor shows the window for images 
visualization.



    Play sound

This command allows you to play a sound. Then, WinAsks Editor shows the window for sounds 
reproduction.



    View animation

This command allows you to view an animation. Then, WinAsks Editor shows the window for animations 
visualization.



 Play video

This command allows you to play a video. Then, WinAsks Editor shows the window for videos 
reproduction.



    Set record options

This command allows you to set the options relative to a record. If the program is in SHOW mode, then you
can only see the options but you cannot modify them.



    Show first record

This command allows you to return to the first record in the questionnaire and view it.



    Go 10 records back

This command allows you to go 10 records back in the questionnaire and shows the record found.



    Show previous record

This command moves to the previous record in the questionnaire and shows it.



    Add a new record

This command allows you to add a new record (question) to the questionnaire. Independently from 
current position, the record is added at the questionnaire end.



    Insert a record

This command allows you to insert a record in the questionnaire. The new record is inserted in the 
position that precedes the current one.



    Edit a record

This command allows you to edit the currently shown record.



    Cancel operation

This command allows you to cancel the operation you were performing, that is adding, inserting or editing 
a record of the questionnaire.



    Confirm operation

This command allows you to confirm the operation you were performing, that is adding, inserting or 
editing a record of the questionnaire.



    Show next record

This command moves to next record in the questionnaire and shows it.



    Go 10 records forward

This command moves 10 records forward in the questionnaire and shows the record found.



    Show last record

This command moves to the last record in the questionnaire and shows it.



 Print a questionnaire / analysis

This command allows you to print the current questionnaire / analysis.



    Close a questionnaire / analysis

This command allows you to close the current questionnaire / analysis. If you made any changes from the
last saving, WinAsks Editor asks for a further confirm and, in case, saves changes.



    Search file

This command allows you to search a specified unit for a file. For a quicker search, you can insert 
keywords.



    Delete file

This command allows you to delete from disk the specified file.



    Show information

This command allows you to show general information about the current questionnaire or analysis.



    Save file as

This commands saves a copy of the current file with a different name.



    Compile questionnaire

This command allows you to compile the questionnaire so that it can be run on the screen with the 
WinAsks Player program.



    Export questionnaire / analysis / chart

· If the questionnaire window is active
This command allows you to export the current questionnaire in text format.

· If the analysis window is active (table)
This command allows you to export the current table in text format.

· If the analysis window is active (chart)
This command allows you to export the current chart in BMP or WMF format.



    Insert questionnaire

This command allows you to insert a new questionnaire into the current one.



    Set printer

This command allows you to set the printer to use.



    Open file 1

This command opens the file number 1 in the list of the last 4 opened files.



 Open file 2

This command opens the file number 2 in the list of the last 4 opened files.



 Open file 3

This command opens the file number 3 in the list of the last 4 opened files



 Open file 4

This command opens the file number 4 in the list of the last 4 opened files.



    Exit program

This command quits WinAsks Editor. If you made any changes from last saving, WinAsks Editor asks for 
a further confirm and, in case, saves changes.



    Clear Clipboard

This command allows you to delete from memory the eventual contents of the Clipboard.



    Select all

· If the questionnaire window is active
This command allows you to select automatically all the text contained in the active text box.

· If the analysis window is active (table)
This command allows you to select automatically all the data entered in the current table.



    Set font

· If the questionnaire window is active
This command allows you to select font, style and color to be used for the current text

· If the analysis window is active (chart))
This command allows you to select font and style to be used for the current chart.



    Find

This command allows you to search for a specified string in the current questionnaire / analysis .



    Find next

This command allows you to repeat searching for the previously specified string in the current 
questionnaire or analysis.



    Show a specific record 

This command finds and shows the specified record.



    Show Browser

This command shows the Browser of the current questionnaire.



    Swap two records

This command allows you to swap positions of the two specified records.



    Delete record

This command allows you to delete the current record from the questionnaire.



    Associate image

This command allows you to associate an image to the current record.



 Associate sound

This command allows you to associate a sound to the current record.



 Associate animation

This command allows you to associate an animation to the current record.



 Associate video

This command allows you to associate a video to the current record.



    Dissociate image

This command allows you to dissociate the selected image from current record.



 Dissociate sound

This command allows you to dissociate the selected sound from current record.



 Dissociate animation

This command allows you to dissociate the selected animation from current record.



 Dissociate video

This command allows you to dissociate the selected video from current record.



    Show information

This command shows information about the current record.



    Set data

This command allows you to select the data to be requested before filling in current questionnaire.



    Set messages

This command allows you to select the messages which must be shown during current questionnaire 
execution.



    Set objects

This command allows you to set the multimedia objects that must be reproduced during current 
questionnaire execution.



    Create link

This command allows you to link the current questionnaire to the other ones already created.



 Set score

This command allows you to define the score for each record of the current questionnaire.



 Set evaluation

This command allows you to define the evaluation intervals of the current questionnaire.



 Set questionnaire options

This command allows you to set the general options of the current questionnaire.



    Set environment options

This command allows you to set all the general options relative to the program work environment.



 Customize Toolbar

This command allows you to customize the program Toolbar, inserting the most used functions.



 Show questionnaire status

This command shows current questionnaire status, that is the program finds and shows all the objects 
(images, sounds, animation and videos) used in the questionnaire. If an object is not present (for example
it was deleted or moved), its absence will be pointed out. 



 Show tips

This command shows you some useful hints about the correct program functioning.



 Arrange active windows

This command allows you to arrange active windows, so that it can show the title bar of each window.



 Show text window

This command allows you to show the window for managing text. It's similar to Notepad, but offers 
additional features.



 Load WinAsks Player

This command loads WinAsks Player, the program for running questionnaires / surveys on video.



 Show help

This command allows you to show the index of program guide.



 Import data

This command allows you to import data in text format into the current table.



 Inserts cells

This command allows you to insert new cells (rows or columns) in the current table.



 Delete cells

This command allows you to delete the selected cells (or their contents) from current table.



 Insert tab

This command allows you to insert a new tab in the current analysis. The tab can include a table or a 
chart.



 Delete tab

This command allows you to delete the current tab from the analysis



 Add record

This command allows you to add a record, that is the result of questionnaire / survey execution, to the 
current table.



 Add more records

This command allows you to add more records, that is record the results of questionnaire / survey 
execution, to the current table. 



 Apply filter

This command allows you to apply a filter to current data. This way you can know, for example, who gave 
a certain answer, who got a particular score, ...



 Sort data

This command allows you to sort current data. You can specify several sorting criteria, for example, you 
can sort by surname, totalized score, ...



 Show statistics

This command allows you to calculate and view some statistics about the currently selected data. 



 Calculate frequency

This command allows you to calculate and view the frequency of the currently selected data. This way 
you can know, for example, how many people gave a certain answer, which answer is the most 
frequent, ...



 Calculate a cross table

This command allows you to calculate and view a cross table. The program relates the answers of two 
questions and shows all the information, statistics and percentages of this analysis.



 Create chart

This command allows you to create automatically a chart of the selected data.



 Select chart type

This command allows you to select a different type (pie, bars, area, lines, ...) for the current chart.



 Set chart options

This command allows you to set all the options (color, glossary, ...) of the current chart.



 Delete chart

This command allows you to delete the current chart.



 Show / Hide cells

This command allows you to show or hide the cells of the current table. This way you can show only a 
part of the data, and on this part you can perform analyses and creates charts.






